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1. BOARD LAYOUT AND FUNCTION
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Figure 1: MAKER-UNO-RP2040 Board Functions (TOP)

Function

Description

LiPo / Li-lon

® JST-PH 2-pin connector for LiPo / Li-lon battery.
® Connectto single cell LiPo / Li-lon battery. The battery is rechargeable
via USB.

Batter
ConneZtor * The battery is protected from overcharged and over discharged. If the
board cannot be turned on when the battery is connected, please
charge the battery to activate the battery protection circuit.
On/Off Switch | @ Slide switch used to turn on or off the power.
. ® LED Indicator for the LiPo/Li-lon battery charging status.
Charging LED ® Turns on when the battery is charging and off when the battery is full
USB Type-C ® Used for both powering and programming the board from a PC.
Reset Button @ Button used to reset the RP2040.
@ Press to restart the board without unplugging the USB cable or battery.
@ Button used to enter bootloader mode.
® Press and hold this button while resetting the Maker Uno RP2040 to
Boot Button

enter bootloader mode. This mode is used to load either the
Micropython/Circuitpython firmware or custom C/C++ firmware onto
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the device."
Function Description
User ® Accessible from the user program.
Programmable
Button @ Internally connected to GP2.

Grove Ports

® 4-pin, 2.0mm pitch, Grove connector for external grove modules.
@® Pins connection;

Grove Port | GPIO | PWM SPI 12C | UART | Analog
1 0 PWMO0-A | SDIO [ SDAO TXO0 =
1 PWMO-B | CSn0 [ SCLO RX0 =
) 4 PWM2-A | SDIO | SDAO TX1
5 PWM2-B | CSn0 | SCLO RX1
6 PWM3-A | SCKO | SDA1 - -
3 26 PWM5-A | SCK1 | SDA1 - ADCO
7 PWM3-B | SDOO | SCL1 - -
4 27 PWM5-B | SDO1 | SCL1 - ADC1
5 28 PWM6-A | SDI1 | SDAO TX0 ADC2
29 PWM6-B | CSnl | SCLO RX0 ADC3
6 20 PWM2-A | SDIO | SDAO TX1
21 PWM2-B | CSn0 | SCLO RX1

@ |ST-SH 4-pin Connector for external modules or sensors.
® Compatible with QWIIC / Stemma QT / Grove (with conversion

Maker Port
cable).
* The pins are shared with the Grove 6 port (GPIO 20, 21).

Pin Header @® Female connector for external connection.

@ Connectors for 4 x RC servo motors.
Servo Ports ® Signal (.S) is internally connected to GP14, GP15, GP16 and GP17

respectively.

® Servo Voltage is equal to the power source voltage.
SPI Port ® Male header for SPI communication.
RGB LEDs ® User programmable WS2812B RGB LED.
(WsS2812) @ Internally connected to GP25.

® LED indicators for RP2040 GPIOs that are connected to the socket
GPIO Status LEDs header.

® Turns on when the GPIO state is high.

® LED indicator for 3.3V and 5V.
Power LEDs

® Turn on when powered up.

@ Slide switch used to mute the piezo buzzer (placed at the bottom
Buzzer Mute
Switch layer of the PCB).

® Suggested to use if GP8 is used for other purposes.
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Table 1: MAKER-UNO-RP2040 Board Functions
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Figure 2: MAKER-UNO-RP2040 Board Functions (Bottom)
Function Description
@® Microcontroller for the Maker Uno RP2040 board.
Raspberry Pi ® Low-cost, high-performance microcontroller equipped with a dual-
RP2040 core ARM Cortex-M0+ processor, ample memory, and versatile [/0

options.

Piezo Buzzer

® Programmable piezo buzzer, can be used to play tone or melody.
@ Internally connected to GP8.

Digital 10 LEDs power trace.
Disable Solder | ® Cut (open) the connecting trace to disable the digital 10 LEDs.

Jumper

® Default closed solder jumper that connects 3.3V with 10s LED

@ This action can help to conserve power or reduce distraction from
the 10 LEDs.

Table 2: MAKER-UNO-RP2040 Board Functions (Bottom)
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2. PWM ON RP2040

The RP2040 PWM block is composed of 8 slices (PWMO0O, PWM1, PWMZ2...), each having the
capability to drive two PWM output signals, A and B resulting in a total of up to 16 controllable
PWM outputs. Each GPIO pin is assigned with a PWM slice and output, which is also referred to
as a channel. Therefore, all RP2040 GPIO pins support PWM. However, if the GPIO pins share the
same PWM channel, simultaneous PWM usage is not possible.

Note that for the Maker Uno RP2040 not all GPIO pins of the RP2040 are broken out and
connected, the table below highlights potential channel conflicts that may occur. Please refer to
the pinout diagram in the next section for detailed information about each pin's PWM channel.

PWM Channel GPIO
0
PWMO-A
16 (Servo 3)
PWMO0-B B
17 (Servo 4)
4
PWM2-A
20
5
PWM2-A
21

Table 3: Shared PWM channel for connected GPIO pins.
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3. SPECIFICATION

No Parameters Min | Max | Unit
1 |Power Input Voltage (USB or LiPo/Li-Ion) 3.6 6 \Y
Low Level -0.3 0.8 \%
2 | Digital Input Voltage
High Level 2.0 3.6 \Y
Low Level 0 0.5 \Y
3 [ Digital Output Voltage
High Level 2.62 | 33 \
4 | Analog Input Voltage 0 3.3 \Y
5 | Total +3V3 Output Current - 500 | mA
6 | Total +5V Output Current - 600 | mA
7 | Vservo (Only USB is connected) VUSB - 0.4 \Y
8 | Vservo (Only LiPo/Li-lon is connected) *VBAT \Y
9 | Vservo (USB and LiPo/Li-lon are connected) VUSB - 0.4 \Y
10 | Operating Temperature -20 85 °C
VID 0x2E8A
11 USB VID & PID
(CircuitPython & Arduino Core)
PID 0x1071 c

Table 4: MAKER-UNO-RP2040 Absolute Maximum Ratings

*VBAT is the voltage of the LiPo/Li-lon battery.
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4. DIMENSION
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Figure 4: MAKER-UNO-RP2040 Dimension
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5.SETTING UP FOR ARDUINO IDE, CIRCUITPYTHON OR

MICROPYTHON

In this guide, we will walk you through setting up your Maker Uno RP2040 for three different
programming platform; CircuitPython, Arduino IDE and MicroPython. We'll then test each setup
with a simple blink code to ensure everything is working correctly.

Prerequisites:

Maker Uno RP2040

USB-C cable

Computer with a USB port

Corresponding IDEs/coding softwares for each coding platform.

ARDUINO IDE

For this guide, it is written based on Arduino IDE version 2.

Before starting programming the board you will need to add the Maker Uno RP2040 to the
Arduino Boards Manager.

1.

2.

Open the Arduino IDE and navigate to the following directory: File > Preferences >
Settings.

File Edit letch Tools Help

New Sketch Ctrl+N

Open...

Open Recent

Sketchbook

Examples

Close

Save

Save As...

Preferences... Ctrl+Comma

Advanced

Quit Ctrl+Q BUILTIN, OUTPUT);

Scroll to the bottom of the window pane and locate the "Additional Boards Manager URLs"
box and paste this following URL: https://github.com/earlephilhower/arduino-
pico/releases/download/global/package rp2040 index.json. Click “OK” to close the
window.
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Preferences X

() Show files inside Sketches

Editor font size 14

Interface scale ® Automatic 100 %

Theme Light v

Language: English v (Reload required)

Show verbose output during (] compile (Jupload

Compiler wamings None v

() Verify code after upload Paste the link here

Auto save
Editor Quick Suggestions
Additional boards manager URLs: https:/github.com/earlephilhower/arduino-pico/releases/download/global/pack..

CANCEL

Note: If you already have URLSs for other boards, you can separate them with commas like this:

https://github.com/earlephilhower/arduino-
pico/releases/download/global/package_rp2040_index.json,
https://raw.githubusercontent.com/espressif/arduino-esp32/gh-pages/package_esp32_index.json

3. Open the Boards Manager by clicking the board manager icon or navigating to Tools >
Board > Boards Manager. Search for the word "uno rp2040," and the Raspberry Pi
Pico/RP2040 by Earle F. Philhower board package should appear, as shown in the
picture below. Click "Install” to install the board package.

File Edit Sketch Tools Help

Q e 3 Arduino Uno

BOARDS MANAGER Blink.ino

10 vy M LUy Jududliu
uno rp20400—>g 17 a4 cep 20

Type:  All v 18 ‘~
19
20 —_—

0 Raspberry Pi Pico/RP2040 by Earle F. Philhoweer, Ill ---

21
Boards included in this package: Raspberry Pi Pico, Raspberry 22
Pi Pico W, 0xCB Helios, Adafruit Feather RP2040, Adafruit 23
Feather RP2040 SCORPIO, Adafruit Feather RP2040 DVI,... 24
More info 25 kit Sekiin: s
37D W W 26 void setup() {
27 initialize dig
28 pinMode (LED BUILT]
29}
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4. After installation completed. Select Maker Uno RP2040 board from Tools >

Board>Raspberry Pi Pico/RP2040> Cytron Maker Uno RP2040.

Boards Manager...

File Edit Sketch Tools Help

° e uto Format
s .rchive Sketch
Blink.ino
19 a0e Libraries..

Serial Monitor
Serial Plotter
Firmware Updater

Upload SSL Root Certificates

NowhAwWwN R

Board: "Cytron Maker UNO RP2040
Port: "UF2_Board"

Get Board Info

Debug Level: “None®

Debug Port: "Disabled”

C++ Exceptions: "Disabled”

Flash Size: "2MB (no FS)*

CPU Speed: "133 MHz"
IP/Bluetooth Stack: “IPv4 Only"
Optimize: "Small (-Os) (standard)”
RTTI: "Disabled”

Stack Protector: "Disabled™

Upload Method: "Default (UF2)"

Arduino AVR Boards

® Raspberry Pi Pico/RP2040

Arduino Mbed OS RP2040 Boards

Ln1,Col1

3 >

Cytron Maker

Adafruit Feather RP2040 USB Host
Adafruit Feather RP2040 CAN
Adafruit Feather RP2040 Prop-Maker
Adafruit ItsyBitsy RP2040
Adafruit Metro RP2040

Adafruit QT Py RP2040

Adafruit STEMMA Friend RP2040
Adafruit Trinkey RP2040 QT
Adafruit MacroPad RP2040
Adafruit KB2040

Arduino Nano RP2040 Connect
ArtronShop RP2 Nano

BridgeTek IDM2040-7A 4
Cytron Maker Nano RP2040

Cytron Maker Pi RP2040

Cytron Maker Uno RP2040
DatanoiseTV PicoADK

Degz Robotics Suibo RP2040
DeRuilab FlyBoard2040Core
DFRobot Beetle RP2040

L'atelier d'Amoz DudesCab

5. Next, to upload code to the Maker Uno RP2040 for the first time, you need to ensure it is in
bootloader mode. For that, firstly connect the board to your computer using a USB-C cable

and turn on the board.

Slide downward
to turn on the
board

et

L
Cytron> x ARUS

MAKER UNO RP2040 i 18

[ H ]

{ FR 1

cicl

g

Connect to
your computer

6. Press and hold the “BOOT” button and then press the “RESET” button. Make sure you
release the “RESET” button first before releasing the “BOOT” button.
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1) Press RESET
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7. Select the corresponding COM port by selecting Tools>Port. Now we are all set to program
and upload the code to the Maker Uno RP2040 board!

Usually, the COM port will initially appear as "UF2_Board". After the upload is successful,
the board will reset, and the COM port will then reappear as its corresponding port.

File Edit Sketch Tools Help

uto Format

s .rchive Sketch

Blink.ino 1

age Libraries...
Serial Monitor
Serial Plotter
Firmware Updater

Upload SSL Root Certificates

Board: "Cytron Maker UNO RP2040"

Port: "UF2_Board"

Get Board Info

Debug Level: “None™

Debug Port: "Disabled"™

C++ Exceptions: "Disabled”
Flash Size: "2MB (no FS)*

CPU Speed: "133 MHz"
IP/Bluetooth Stack: “IPv4 Only*
Optimize: "Small (-Os) (standard)"
RTTI: "Disabled”

Stack Protector: "Disabled”

Upload Method: "Default (UF2)"

Adafruit Feather RP2040 USB Host
Adafruit Feather RP2040 CAN
Adafruit Feather RP2040 Prop-Maker
Adafruit ItsyBitsy RP2040
Adafruit Metro RP2040
Adafruit QT Py RP2040
Adafruit STEMMA Friend RP2040
Adafruit Trinkey RP2040 QT
Boards Manager... Adafruit MacroPad RP2040
Arduino AVR Boards AT EL

Arduino Mbed OS RP2040 Boards Archino Nano RP2040 Conect

® Raspberry Pi Pico/RP2040 ArtronShop RP2 Nano

BridgeTek IDM2040-7A 4
Cytron Maker Nano RP2040

Cytron Maker Pi RP2040

Cytron Maker Uno RP2040
DatanoiseTV PicoADK

Degz Robotics Suibo RP2040
DeRuilab FlyBoard2040Core
DFRobot Beetle RP2040

L'atelier d’Amoz DudesCab

Note: You might need to recheck and reselect the COM port for the next sketch/code upload.

8. Now let’s try uploading a simple sketch. Copy the code below into the Arduino IDE. Verify
and upload the sketch by clicking by clicking the "Upload" icon in the Arduino IDE

void setup() {

pinMode(1, OUTPUT);
}

//Turn an LED on for one second, then off for one second, repeatedly.

// initialize digital pin LED_BUILTIN as an output.

// the loop function runs over and over again forever

Created by Cytron Technologies Sdn Bhd — All Rights Reserved
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void loop() {
digitalWrite(1, HIGH); // turn the LED on (HIGH is the voltage level)

delay(1000); // wait for a second
digitalWrite(1, LOW); // turn the LED off by making the voltage LOW
delay(1000); // wait for a second

}

9. Ifthe code is successfully uploaded to the board, an output message as shown in the figure
below should appear, and the onboard LED1 should be blinking every one second.

Output x O
Sketch uses 52260 bytes (2%) of program storage space. Maximum is 2093056 bytes.
Global variables use 10232 bytes (3%) of dynamic memory, leaving 251912 bytes for local variables. Maximum is 262144 bytes
Converting to uf2, output size: 140288, start address: 8x2000
Scanning for RP2040 devices
Flashing D: (RPI-RP2)
Wrote 140288 bytes to D:/NEW.UF2

Ln1,Col 1 Cytron Maker UNO RP2040 on UF2_Board [not connected] (33 B

Created by Cytron Technologies Sdn Bhd - All Rights Reserved 11
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CIRCUITPYTHON

There are many software options you can use to program CircuitPython and MicroPython, even
simple text editors like Notepad will do the work. For this guide, Thonny IDE is chosen as the
coding software. Please download the IDE from the following link: https://thonny.org/

1. Connect the board to your laptop, power up the board and then enter bootloader mode by
pressing and holding the “BOOT” button, followed by pressing the “RESET” button.

1 Press RESET

; Press & hold
L DOy x QRUS BoOT
K @\ MAKER UNO RP2040

"
o
>

Make sure you switch on the board first before start flashing your code

Continue to hold the “BOOT” button until the RPI-RP2 drive as shown in the figure below
appeared

= RPI-RP2 (D:) +

a0 C RPI-RP2 (D:) Search RPI-RP2 (D) Q

® New N Sort = v “ee (1 Details

& Pictures » Name Date modified
® Music - @ INDEX

I maker-uno-r # B INFO_UR2

# videos »

W Telegram Deski

I Screenshots

I product image

I DATASHEETARC
RPI-RP2 (D:) (2 items)

M This PC Select a single file to get more
© information and share your
cloud content.

& RPI-RP2 (D)
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2. The next step is to flash the CircuitPython firmware onto the board. There are two ways it
can be done;

a. Paste the CircuitPython .uf2 file to the Raspberry Pi Drive
i. Download the latest CircuitPython firmware for the Maker Uno RP2040 board
from the CircuitPython website.

circuitpython.org,

cireui
p e o

Maker Uno RP2040
by Cytron Technologies

CircuitPython 9.0.0-beta.2

This is the latest development release of CircuitPython that will work with the Maker
Uno RP2040.

Alpha development releases are early releases. They are unfinished, are likely to
have bugs, and the features they provide may change. Beta releases may have
some bugs and unfinished features, but should be suitable for many uses. A Release
Candidate (rc) release is considered done and will become the next stable release,
assuming no further issues are found.

Please try alpha, beta, and rc releases if you are able. Your testing is invaluable: it
helps us uncover and find issues quickly.

Release Notes for 9.0.0-beta.2

ENGLISH (US)

o«

DOWNLOAD .UF2 NOW &

Built-in modules available: _asyncio, _bleio, _pixelmap, adafruit_bus_device,
adafruit_pixelbuf, aesio, alarm, analogbufio, analogio, array, atexit, audiobusio,
audiocore, audiomixer, audiomp3, audiopwmio, binascii, bitbangio, bitmaptools,
bitops, board, builtins, builtins.pow3, busdisplay, busio, busio.SPI, busio.UART,

ii.  Drag the adafruit_circuitpython_etc.uf2 file you have downloaded to the RPI-
RP2 drive.

Created by Cytron Technologies Sdn Bhd - All Rights Reserved 13
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+ Downloads 9

& qp Downloads > Search Downloads

® New v X ) @D ® 0] N Sort v O View v e (B Details

! Documents #
- Downloads #
& Pictures &

® Music »

B Videos » adafruit-circuitpy
thon-cytron_mak
er_uno_rp2040-e
n_US-9.0.0-beta...
M This PC
Drag the .uf2 to this drive
& RPI-RP2 (D2)
adafruit-circuitpython-
cytron_maker_uno_rp2040-

The RPI-RP2 drive will disappear and a new disk drive called CIRCUITPY will appear.
= This PC X aF

« G > ThisPC > Search This PC Q

8= View v aee (1 Details

A Pictures b v Devices and drives

(JED < ] —

B Videos . 343 GB free of 475 GB

CIRCUITPY (D) 'I
4= I

0.97 MB free of 0.98 MB
B This PC

v & CIRCUITPY (D:)
m fseventsd

i lib

This PC (2 items)

2 items |
b. Paste the CircuitPython .uf2 file to the Raspberry Pi Drive

i.  Openthe Thonny IDE, look at the bottom right corner of the window, select 'Install
CircuitPython...".

Created by Cytron Technologies Sdn Bhd - All Rights Reserved 14
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v

Local Python 3 « Thonny's Python =

v Local Python 3 « Thonny's Python
Install MicroPython...

| Configure interpreter...

Local Python 3 « Thonny's Python =

ii.  Select the correct target volume and CircuitPython family as shown in the figure
below. Then, choose the variant as "Cytron Technologies « Maker Uno RP2040"

K Install or update CircuitPython (UF2) X |

Target volume [RPI-RP2 (D) v
family RP2
CircuitPython family [RP2 ”o
variant v
version Boardsgurce « Blok

N P Y
info |Cytron Technologies « EDU PICO for Pico W
(Cytron Technologies « Maker Nano RP2040 I
(Cytron Technologies « Maker Pi RP2
C - -

- TV « PicoADK - Audio Development Kit
ELECFREAKS « Pico:ed
Electrolama « minik Octave
Hack Club « Sprig

iii.  Click Install. You should get the output 'Done!" and a new disk drive called
CIRCUITPY will appear.
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Target volume |RPI-RP2 (D:)
family RP2

CircuitPython family |RP2
variant Cytron Technologies « Maker Uno RP2040
version (9.0.0-beta.2

info https://circuitpython.org/board/cytron maker uno rp2040/

m S

N Sort v 8= View v (1 Details

A Pictures 2 Devices and drives

® Music Acer (C)

B Videos 343 GB free of 475 GB

CIRCUITPY (D)

0.97 MB free of 0.98 MB
B This PC

& CIRCUITPY (D2)
W fseventsd

i lib

This PC (2 items)

3. Now let's try a simple code to verify that everything is working correctly. At the bottom
right corner of the window make sure the correct Configure Interferer, CircuitPython
(generic) and COM are shown and chosen.

9.0.0-beta.2 on 2024-02-20; Cytron Maker Uno RP2040 with rp2040 Make suraicorrect COMShow

Local Pythg « Thonny's Python

v CircuitPython (generic) « CircuitPython CDC control @ COM44

Configure interpreter...

CircuitPython (generic) « CircuitPython CDC control @ COM44 =

4. Copy this code below and Click the Run icon to run the code.

Created by Cytron Technologies Sdn Bhd - All Rights Reserved 16



Simplifying Digital Making
Datasheet - MAKER-UNO-RP2040

import board
import digitalio
import time

led = digitalio.DigitalinOut(board.GP1)
led.direction = digitalio.Direction.OUTPUT

while True:
led.value = True
time.sleep(0.5)
led.value = False
time.sleep(0.5)
T
File Edit View Run Tools Help
DB O e =
Files code.py

5. The onboard LED 1 should be blinking by 0.5 second. To stop the execution of the program,
click the STOP button or simply press CTRL+C.

T
File Edit View Run Tools Help
DSHE O ©
Files code.py
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